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1. Overview 
"DynaDoctor V" analyses data sent from the Dynakit, and supports the status display of outdoor and 

indoor units. This tool can be used to check refrigerant cycle data, display various data graphs, execute 

indoor unit test runs and create reports of test run results. 

Furthermore, received data can be saved and browsed, and secondary use of data can be carried out 

easily. 

 

 

2. Operating Environment 
The following is the ideal operating environment for this software:  

 
Item Specifications 

PC Windows 7 Windows 8.1 Windows 10 compliant 
Operating System Windows 7 Windows 8.1 Windows 10 compliant 
Microsoft Excel Excel 2003 or later 
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3. DynaDoctor V basic operation 
3.1. DynaDoctor V functions 

3.1.1. Check refrigerant cycle data 

A refrigerant cycle data check can be performed using DynaDoctor V. This function allows for visual 

checking of the status of outdoor and indoor units. 

  
Figure 3.1.1 
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3.1.2. Save/browse data 

Data communicated by the Dynakit can be saved. Furthermore, this saved data can be used to check 

past data. 

 

  

Figure 3.1.2 
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3.1.3. Display data graphs 

Data graphs for indoor and outdoor units can be displayed using saved data. Viewing several graphs 

together makes it easy to compare data. 

 

  
Figure 3.1.3 
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3.1.4. Air conditioner test runs 

Test runs can be executed on connected indoor units. Furthermore, received data can be used to create 

reports of test run results. 

 

 
Figure 3.1.4 

  



 

 
9 / 68 

3.2. Starting/exiting DynaDoctor V 

3.2.1. Start-up DynaDoctor 

DynaDoctor V can be started up in 2 ways, using a desktop shortcut or the Windows menu. 

①  Start-up DynaDoctor 

・ Using a desktop shortcut 
Double-click the desktop shortcut. 

 

・ Using the Windows menu 
In the [Start] menu, select [All Programs] > [Toshiba] > [DynaDoctor V] > [DynaDoctor V]. 

 

② When DynaDoctor V has started-up 
The DynaDoctor V main menu screen is displayed when DynaDoctor V has started-up. The functions 

can now be used. 

 

 
Figure 3.2.1 
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3.2.2. Exiting DynaDoctor V 

Click the [Cancel] button to exit DynaDoctor V. 

 

 
Figure 3.2.2 

 

  

Cancel button 
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4. Using DynaDoctor V 
DynaDoctor V uses an MDI window. Each window is displayed inside the MDI window. 

 

4.1. Displaying data 

Choose the button for the connected model from the [Outdoor unit] group box. 

 

 
Figure 4.1.1 

 

The MDI parent window opens. If the communication function is unavailable, a message is displayed. 

Choose [Yes] to open the window. Choose [No] to return to the main menu. 

 
Figure 4.1.2 

 

When communication is possible, or when browsing data, a wait screen is displayed while the screen 

renders. 

  

Outdoor unit group box 
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Figure 4.1.3 

 

When the screen has been rendered, a system configuration diagram window opens. 

 

 

Figure 4.1.4  
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4.2. Saving received data 

To save communication data, select [Save...] from the [File] menu. A save window opens. 

 
Figure 4.2.1 

 

To choose the save destination, click the [Browse] button. A save file dialogue is displayed. Choose a 

save destination. The destination file path is displayed in the window. 

Change the [Data Sampling Time] to alter the frequency with which data is saved to the file. Comments 

can also be added to files. 

 

 

Figure 4.2.2 

 

Click the [OK] button to start saving data to the file. 

 

 
Figure 4.2.3 

  

Browse button 

File Name 

Data sampling time 

OK button 
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4.3. Browsing saved data 

Data saved in Saving received data can be browsed. To browse data, choose [Browse...] from the [File] 

menu. A file browsing window opens. 

 
Figure 4.3.1 

 

Click the [Refer to] button to select which data to browse. An open file dialogue is displayed. Select a file. 

The destination file path, save date and data count are displayed on the screen. If there are any 

comments attached to the file, they are also displayed. 

 

 

Figure 4.3.2 

 

Click the [OK] button to start browsing the file. 

 

 
Figure 4.3.3 

  

Refer to button 

File Name 
Data Count 

OK button 
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When browsing files, [Record No.], a scroll bar, [Time] (time elapsed since the first piece of data was 

saved) and [Date & Time] (time that data was received) are displayed. 

 

 

 
Figure 4.3.4 

 

 

 

Move the scroll bar to change the data being displayed. A number can also be entered directly into 

Record No. to change the displayed data. 

 

 

4.4. Editing data files 

File comments saved in Saving received data can be edited. To edit comments choose [Edit...] from the 

[File] menu. A file edit window opens. 

 

Figure 4.4.1 

 

Click the [Renewal] button to select which data to edit. An open file dialogue is displayed. Select a file. 

The destination file path, save date and data count are displayed on the screen. If there are any 

comments attached to the file, they are also displayed. 

  

Time that data 
was received 

Record No. 

Scroll bar Time elapsed since the first 
piece of data was saved 
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Figure 4.4.2 

 

Click the [OK] button to save the edited comments. 

 

 
Figure 4.4.3 

 

 

4.5. Communication settings 

Communication settings can be changed. To open the communication settings window, select [Set up...] 

from the [File] menu. 

 
Figure 4.5.1 

 

The COM port on the computer which is running the system is displayed in [Port Setting]. To change the 

COM port used for the connection, select a COM port from the list. Press the [Set] button to change the 

COM port. 

  

Renewal button 

File Name 
Data Count 

OK button 
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Figure 4.5.2 

 

 

 

4.6. Printing out the screen 

The displayed screen can be printed out. To open the print settings window, select [Print...] from the [File] 

menu. 

 
Figure 4.6.1 

 

Click the [Property] button to change the printer settings. A print dialogue is displayed. The number of 

copies can also be input directly. 

 

 
Figure 4.6.2 

 

Port Setting 

Set button 

Property button 

No. of copies 
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Figure 4.6.3 

 

Click the [OK] button to print out the screen. 

 

 

4.7. Finishing communicating/browsing 

To finish communicating with the outdoor unit or browsing a data file, select [Select Type...] from the 

[Connect] menu. 

 
Figure 4.7.1 

 

A finish confirmation message is displayed. Click [OK] to end communication/browsing and go to the main 

menu. 

 

 
Figure 4.7.2 
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4.8. Managing the windows 

Use the [Window] menu to manage the open windows. 

 

 
Figure 4.8.1 

 

4.8.1. Displaying windows side by side 

Choose [Tile] from the [Window] menu to display windows side by side. The open windows are 

automatically lined up and positioned. 

 

 
Figure 4.8.2 

 

 
Figure 4.8.3 
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4.8.2. Displaying windows in a cascade 

Choose [Cascade] from the [Window] menu to display windows in a cascade. The open windows are 

automatically stacked and positioned. 

 

 
Figure 4.8.4 

 

 

Figure 4.8.5 
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4.8.3. Displaying a specific window at the front 

To display a specific window at the front, select the appropriate window from the [Window] menu. The 

selected window is displayed at the front. 

 

 

Figure 4.8.6 

 

 

 
Figure 4.8.7 
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5. Refrigerant cycle diagrams 
5.1. Displaying a system configuration diagram (communication) 

A system configuration diagram for the air conditioner currently connected or being browsed can be 

displayed. To display a system configuration diagram, select [System Diag] from the [Ref. Cycle] menu. 

 

  
Figure 5.1.1 

 

A wait screen is displayed while data is loading. The system configuration diagram is displayed when data 

has finished loading. 

The system configuration diagram can be used to check the indoor/outdoor unit connection or operation 

status. 

 

 
Figure 5.1.2 
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5.2. Displaying a system configuration diagram (refrigerant cycle) 

The refrigerant cycle for the air conditioner currently connected or being browsed can be displayed. Refer 

to Displaying a system configuration diagram (communication) or Displaying a refrigerant cycle diagram 

(system data) for information on displaying the refrigerant cycle window. 

 

Click the [System Configuration Diagram (Refrigeration Cycle)] tab in the system configuration diagram 

window to display a refrigerant cycle diagram for the whole system. 

 

 
Figure 5.2.1 

 

Click the [Switch] button to switch between displaying the refrigerant cycle diagram data item and the 

actual data. Move the [Indoor unit] scroll bar to change the indoor units being displayed (five units at a 

time). 
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Figure 5.2.2 

 

 

5.3. Displaying a refrigerant cycle diagram (system data) 

A refrigerant cycle diagram for each air conditioner currently connected or being browsed can be 

displayed. To display the refrigerant cycle diagram screen, select [Ref. Cycle Diag. - System Data] from 

the [Ref. Cycle] menu. 

  
Figure 5.3.1 

 

A wait screen is displayed while data is loading. The system configuration diagram is displayed when data 

has finished loading. 

The refrigerant cycle for each indoor/outdoor unit can be checked individually on the refrigerant cycle 

diagram screen. 

  

Switch button 
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Figure 5.3.2 

 

Click the [Switch] button to change the display mode. The display modes are [Automatic] and [Fixed]. In 

[Automatic] mode the indoor unit changes once a second. In [Fixed] mode the unit being viewed can be 

changed using the [Indoor unit] scroll bar. 

 

 
Figure 5.3.3 

 

Switch button Indoor unit scroll bar 
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The outdoor unit being displayed can also be changed. Click the [Header], [Follower 1], and [Follower 2] 

buttons to choose an outdoor unit to be displayed. 

 

 
Figure 5.3.4 

 

 

5.4. Displaying list data/system data 

A list of system data can be displayed. To open the system data table window, select [List Data - System 

Data] from the [Ref. Cycle] menu. 

  
Figure 5.4.1 

 

A wait screen is displayed while data is loading. The system data table window is displayed when data 

has finished loading. 

The system data table window can be used to check the status of outdoor/indoor units in a table format. 

  



 

 
27 / 68 

 
Figure 5.4.2 

 

Click [View 1] or [View 2] to switch between the data being displayed. 

 

 

Figure 5.4.3 

 

Figure 5.4.4 
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6. Displaying graphs 
Data can be displayed in graph form. Graphs can be displayed when browsing data files. 

 

6.1. Displaying outdoor unit graphs 

Outdoor unit data can be displayed in graph form. To open the outdoor unit graph item selection window, 

select [Outdoor Unit - System Data] from the [Graph] menu. 

 

 
Figure 6.1.1 

 

The items to be displayed on the graph can be chosen in the outdoor unit graph item selection window. A 

maximum of 6 items can be displayed on the graphs. 

 

 

Figure 6.1.2 

 

Select the desired item and click the [OK] button to display a graph. When the [OK] button is clicked, a 

wait screen is displayed while graphs are rendered. When graphs are rendered the graph display window 

opens. 
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Figure 6.1.3 

 

 
Figure 6.1.4 
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6.2. Displaying indoor unit graphs 

Indoor unit data can be displayed in graph form. To open the indoor unit graph item selection window, 

select [Indoor Unit] from the [Graph] menu. 

 

 
Figure 6.2.1 

 

The items to be displayed on the graph can be selected in the indoor unit graph item selection window. A 

maximum of 20 indoor units can be selected. [Cycle Data] and [Control Data] can be selected when 1 unit 

is chosen. [Indoor Comparison Data] can be selected when 1 or more units are chosen. 

[Cycle Data]/[Control Data] and [Indoor Comparison Data] cannot be selected at the same time. 

 

 
Figure 6.2.2 
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6.2.1. Displaying individual indoor unit graphs 

To display graphs for individual indoor units, select 1 indoor unit and cycle data/control data. Then click 

[OK]. When the [OK] button is clicked, the wait screen is displayed while graphs are rendered. When 

graphs are rendered the graph display window opens. 

 

 

Figure 6.2.3 

 

 
Figure 6.2.4 
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6.2.2. Displaying [PMV Opening, Status] comparison graphs for indoor units 

To display [PMV Opening, Status] comparison graphs for indoor units, select 1 or more indoor units and 

[PMV Opening, Status]. Then click [OK]. When the [OK] button is clicked, the wait screen is displayed 

while graphs are rendered. When graphs are rendered the graph display window opens. 

 

 

Figure 6.2.5 

 

 
Figure 6.2.6 
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6.2.3. Displaying [Suction Temperature, Relative Ability] comparison graphs for indoor units 

To display [Suction Temperature, Relative Ability] comparison graphs for indoor units, select 1 or more 

indoor units and [Suction Temperature, Relative Ability]. Then click [OK]. When the [OK] button is clicked, 

the wait screen is displayed while graphs are rendered. When graphs are rendered the graph display 

window opens. 

 

Figure 6.2.7 

 

 
Figure 6.2.8 
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Historical data can be used for [Suction Temperature, Relative Ability] comparison graphs. Refer to 

Browsing saved data for more information about using historical data.  

Move the scroll bar to change the indoor unit display. The temperature scale can also be changed. 

 

 
Figure 6.2.9 
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7. Other functions 
7.1. Checking the list of check codes 

Select [List Check Codes] from the [Menu] menu. The list of check codes window opens. 

 

 
Figure 7.1.1 

 

Choose a check code to display detailed information about it. 

 

 

Figure 7.1.2 

 

7.2. Displaying a system control data table 

Select [System data list] from the [Menu] menu. The system control data table window opens. 
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Figure 7.2.1 

 

In the system control data table window, system control status information being received or browsed 

can be checked in table format. 

 

 
Figure 7.2.2 

 

 

7.3. Changing the displayed pressure data unit 

The unit used to display pressure data can be changed. To change the unit, select [Pressure unit] from the 

[Unit] menu, and choose the desired unit. 

 

 
Figure 7.3.1 
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When the unit is changed, the displayed pressure data is displayed using the selected unit. 

 

7.4. Changing the displayed temperature data unit 

The unit used to display temperature data can be changed. To change the unit, select [Temperature unit] 

from the [Unit] menu, and choose the desired unit. 

 

 
Figure 7.4.1 

 

When the unit is changed, the displayed temperature data is displayed using the selected unit. 

 

 

7.5. Displaying tips 

The system tips display can be turned on or off. Select [Tips] from the [Help] menu to turn it on or off. 

 

  
Figure 7.5.1 

 

When Tips are turned on, system operation information is displayed in the status bar. 

 

 
Figure 7.5.2 
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7.6. Compressing data 

Select [Compress Data] from the [Menu] menu. The compress data window opens. 

 

 
Figure 7.6.1 

 

Use the following procedure to compress data: 

① Specify a folder in which to store the compressed data and a file name. 

② Select the folder or file which the data to be compressed is saved in. 

③ Select the files to be compressed and click the [>>] button or drag and drop them to add them. 

④ To remove selected files, select the file to be removed and click the [<<] button or drag and drop 
it to remove it. 

 

  
Figure 7.6.2 

  

① Specify a folder/file 

③ Click the add button 

④ Click the remove button 

② Select the folder/file 
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To split and save compressed files, click the file section setting menu and choose the size. 

 

 

 
Figure 7.6.3 

 

⑤ Select [Compress] from the [Tool] menu on the menu bar to perform compression. 
 

 

Figure 7.6.4 

 

7.7. Combining data 

Select [Combine Data] from the [Menu] menu. The combine data window opens. 

 

 
Figure 7.7.1 

 

Data split and saved using DynaDoctor can be combined into one consecutive file. 

Use the following procedure to combine data: 

① Specify the folder and file name for the combined data file. 

Click the icon 

Choose the size 

⑤ Select compress 
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② Select the folder or file which the data to be combined is saved in. 

③ Select the files to be combined and click the [>>] button or drag and drop them to add them. 

④ To remove selected files, select the file to be removed and click the [<<] button or drag and drop 
it to remove it. 

 

  
Figure 7.7.2 

 

① Specify a folder/file 

③ Click the add button 

④ Click the remove button 

② Select the folder/file 
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⑤ Click the combine button on the tool bar, or select [Combine] from the [Tool] menu on the menu 
bar to combine the data. 

 

 
Figure 7.7.3 

 

  

⑤ Select combine 
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8. ON/OFF Control 
Operation status and settings can be changed by sending a command to indoor units. ON/OFF control 

can be used when communicating with the outdoor unit. 

 

8.1. Executing indoor unit test runs 

Operation status and settings can be changed by sending a command to indoor units. To open the 

ON/OFF controller window, select [ON/OFF control] from the [Action] menu. 

 

 
Figure 8.1.1 

 

When the ON/OFF window opens, controls for operating the connected indoor units are displayed. 

Unconnected indoor unit controls cannot be operated. 

 

 
Figure 8.1.2 
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8.1.1. Changing the operation mode for all units 

The mode for all indoor units can be changed simultaneously. The mode for all units can be 

simultaneously changed to 3 different modes - [Cooling], [Heating] and [Fan]. 

Click the [Cooling], [Heating] and [Fan] buttons to send a mode change command to all indoor units and 

change the operating mode. 

 

 

 
Figure 8.1.3 

 

All units can also be simultaneously switched to Operate, Stop and Test Operation. Click the [Operate], 

[Stop] and [Test Operation] buttons to send a operation status change command to all indoor units and 

change the operation status. 

 

 

8.1.1. Changing operation mode for individual units 

Operation mode for each indoor unit can be changed individually by operating each unit's controls. Click 

the select operation mode button (initially displayed as SEL) to switch between operation modes in the 

following order: [Cooling] ⇒ [Heating] ⇒ [Fan]. Click the [ON], [OFF] or [TEST] button to send a 

command to the relevant unit to change to the chosen operation mode or status. 

 

  

Change mode for all units buttons (Cooling, Heating and Fan) 

Change operation status for all units buttons (Operate, Stop and Test operation) 
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Figure 8.1.4 

 

 

8.2. Storing operation modes 

Click the [Mode store] button to save the current indoor unit's operation mode. When the [Mode store] 

button is clicked, the current indoor unit operation mode is saved. However, saved operation data is 

erased if communication is halted. 

 

 

 
Figure 8.2.1 

  

Mode store 
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8.3. Restoring operation mode 

Operation modes saved in Storing operation modes can be restored. Click the [Mode re-store] button to 

restore the operation mode. When the [Mode re-store] button is clicked, a command to change to the 

saved operation mode is sent to each unit. 

 

 

 

Figure 8.3.1 

 

  

Mode re-store 
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9. Creating test run reports 
Data saved when communicating with outdoor units can be used to create test run reports. The created 

data can also be used to print out test run reports. 

 
9.1. Opening the test operation report window 

Click the [Report for Test Operation] button on the main menu screen. 

 

 
Figure 9.1.1 

 
The report type selection window opens. Choose the data for the relevant outdoor unit from the list. Click 

the [Start] button to open the report for test operation window. 

 

 
Figure 9.1.2 

 

 

  

Report for test operation button 

Start button 
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Figure 9.1.3 

 

9.2. Creating report data 

Enter data into each field on the screen to create report data. The items which can be input are as follows: 

 

Project/Site data 
Item Method Note 
Project/Site Entered by user Required 
System name or No. Entered by user  
Customer Entered by user  
Date Selected by user  
Test result file Selected by user Required 
Customer Entered/Selected by user Required 

Existing data can be selected from the 
drop-down list 

Div./Section (Customer data) Entered by user  
Name (Customer data) Entered by user  
E-mail (Customer data) Entered by user  
Tel (Customer data) Entered by user  
Address (Customer data) Entered by user  
Company name Entered/Selected by user Required 

Existing data can be selected from the 
drop-down list 

Div./Section (Test person name) Entered by user  
Name (Test person name) Entered by user  
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Item Method Note 
E-mail (Test person name) Entered by user  
Tel (Test person name) Entered by user  
Address (Test person name) Entered by user  
Test result Entered by user  
Proposal Entered by user  

 

Outdoor unit information 
Item Method Note 
Installation location Entered by user  
Breaker installation location Entered by user  
No. of outdoor units Selected by user Required 
Equipment name Entered by user  
Equipment number Entered by user  
Piping length Entered by user  
Additional amount of refrigerant Entered by user  
Item(s) to be checked Entered/Selected by user Required for items which can be 

selected 
 

Indoor unit information 
Item Method Note 
No. of indoor units Entered by user Required 
Pattern for each type Selected by user  
Refrigerant name Selected by user  
Date Selected by user  
Inspector Entered by user  
Breaker capacity Selected by user  
Measured value or judgement Entered by user  
Installation location Entered by user  
Model Entered by user  
Equipment number Entered by user  
Item(s) to be checked Entered/Selected by user  

 

Data attachments 
Item Method Note 
Refrigerant cycle operation 
status 

Selected by user Required 

System data list Selected by user  
Indoor unit operation status Selected by user  
Outdoor unit operation graphs Selected by user  
System configuration diagram 
(communication) 

Selected by user  

System configuration diagram 
(refrigerant cycle) 

Selected by user  
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9.2.1. Specifying test result data 

To specify test result data, click the [Search] button. A select file dialogue is displayed. Select the file to be 

used to create the report. 

 

When a file is selected, the file path appears in the test result file text box. 

 

 
Figure 9.2.1 

 

 

9.2.2. Creating customer/test person data 

To create customer/test person data, choose [New customer data] from the drop down menu and enter 

the data. To edit existing customer/test person data, choose the data to be edited from the drop down 

menu and enter the data. 

When report data is registered, the new customer/test person data is added or updated. 

 

 

Figure 9.2.2 

 

 

9.2.3. Entering test results/proposals 

Enter test results data into the [Test Result] text box. Check the [Proposal] box to enter a proposal. Data 

can then be entered into the [Proposal] text box. 

If a proposal is entered, only 5 lines of test result data can be entered. 

 

  

Search button 
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Figure 9.2.3 

 

 

9.2.4. Entering pipe lengths/additional amount of refrigerant 

To enter the amount of added refrigerant and pipe lengths for the whole system, select the [Refrigeration 

amount calculation] menu or click the [Refrigerant calculation] button. Click the [Refrigerant calculation] 

button to open an additional refrigerant amount window. 

 

 

Figure 9.2.4 

 

Refrigerant calculation button 

Test result text box 

Proposal check box 

Proposal text box 

Refrigerant amount 
calculation menu 
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In the calculator for additional refrigerant window, the outdoor unit model can be chosen, and pipe lengths 

can be entered. The entered results are used to calculate the refrigerant pipe length and the amount of 

additional refrigerant. 

 

 
Figure 9.2.5 

 

To calculate the refrigerant pipe length and the amount of additional refrigerant: 

First, check the check box for the total capacity (hp) of the outdoor unit which executed test operation. 

Next, enter the lengths of the connected pipes for each pipe diameter. 

After entering the data, click the [Calculation start] button to calculate the refrigerant pipe length and the 

amount of additional refrigerant. Click the [OK] button to save the calculated results. 

 

  



 

 
52 / 68 

 
Figure 9.2.6 

 

Click the [OK] button to close the calculator for additional refrigerant window, and automatically enter the 

calculated results for the outdoor unit [Pipe length] and [Additional refrigerant amount]. 

 

 
Figure 9.2.7 

 

 

9.2.5. Checking the refrigerant amount calculation formula 

Click the [Formula] button to check the formula for additional refrigerant amount calculation. The formula 

for additional refrigerant amount window opens when the [Formula] button is clicked. 

The formula for calculating the additional refrigerant amount can be checked in the formula for additional 

refrigerant amount window. Click the [Back] button to return to the calculator for additional refrigerant 

window. 

  

Check the box for the corresponding 
capacity (hp) 

Enter the pipe length 
for each diameter 

The calculated refrigerant pipe length 

The calculated amount of 
additional refrigerant 

Save data with the OK button 
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Figure 9.2.8 

 

 

Figure 9.2.9 

  

Formula button 
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9.2.6. Automatically filling in test results 

The test results for outdoor/indoor units can be filled in automatically. To automatically fill in results: 

Outdoor units - click the [Auto fill to non measure item] button in the [Outdoor unit] tab. 

Indoor units - click the [Auto fill to non measure item] button on the [Indoor unit] tab. 

 

 

 
Figure 9.2.10 

 

  

Auto fill to non measure item button 
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Figure 9.2.11 

 

 

If the number of outdoor/indoor units is below the maximum, a confirmation message appears. Click the 

[OK] button to automatically fill in the test results. 

 

Figure 9.2.12 

 

 

9.2.7. Importing screens 

System status can be imported as a picture using the test result file data. Screens can be imported when 

a test result file is saved. 

Select the screen to be imported from the [Data selection] list displayed on screen. Then click the [Import] 

button when it can be clicked. 

 

 

Auto fill to non 
measure item 
button 

Import 
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Figure 9.2.13 

 

The wait screen is displayed while the screen is rendering. When it has been rendered, the selected 

screen is displayed. 

The [Record No.] and scroll bar for browsing data appear on the import screen. Display the data to be 

imported, and select the [Retrieve] menu to import the screen data. Click the [Preview] button to check the 

imported screen data. 

 

  

Data selection 
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Figure 9.2.14 

 

 
Figure 9.2.15 

 

Preview 
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To import a screen from the [Outdoor unit operation graph list], graph items must be selected. If an 

attempt to import the [Outdoor unit operation graph list] is made without any graph items selected, an 

error message is displayed. 

 

 

Figure 9.2.16 

 

 
Figure 9.2.17 

 

 

9.2.8. Registering report data 

Select [Registration/modify] from the [Test report] menu to register entered report data. To register new 

data, select [New report] from the [Test report] menu and allocate a [Report No.]. Then select 

[Registration/modify]. 

 

Graph items 
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Figure 9.2.18 

 
Figure 9.2.19 

 

When [Registration/modify] is clicked a register/modify report data message is displayed. Click [OK] to 

start registering the report data to the database file. If the report data is registered correctly, a registration 

complete message is displayed. 

 

 
Figure 9.2.20 

 

 
Figure 9.2.21 

 

If a test data file which has already been registered is registered again, a test results data confirmation 

message is displayed. 

 

 
Figure 9.2.22 
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9.3. Searching for report data 

Registered report data can be searched. Select [Retrieval/delete] from the [Test report] menu to open the 

test report retrieve window. 

 

 

Figure 9.3.1 

 

In the test report retrieve window, search conditions can be set and relevant report data can be retrieved. 

The following conditions can be set for searches: 

 
Item Method Note 
Report No. Entered by user  
Project/site name Entered by user  
Start date for test Selected by user  
Customer name Entered by user  

 

If no search conditions are set, all of the registered report data will be shown in the search results. 

 

 
Figure 9.3.2 
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9.3.1. Searching by Report No. 

Click the radio button next to [Report No.] to select a report no. to search for. Report numbers can be 

entered when the [Report No.] radio button is selected. 

 

To specify the report numbers to search for, enter numbers in the text boxes next to [Report No.] and [To]. 

If the starting report no. or finishing report no. is unclear, leave the box blank. 

 

 

Figure 9.3.3 

 

Click the [Search] button to search for report data with the specified report no. 

 

 
Figure 9.3.4 

 

If report data is found which fits the set conditions, it is displayed on screen. To display the contents of the 

report data, select the data and click the [Select] button. 

A confirmation message is displayed before the data is displayed. If the currently entered data does not 

need to be registered, click the [OK] button. 

The selected report data is displayed when the [OK] button is clicked. 

  

Search button 
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Figure 9.3.5 

 

 
Figure 9.3.6 

 

9.3.2. Searching by project/site name, test start date and customer name 

To select and search for project/site name, the test start date or customer name, click the radio button 

next to [Other]. When the [Other] radio button is selected, project/site name, the test start date and 

customer name can be entered. 

 

To search for a project/site name, check the [Project/Site name] check box. When [Project/Site name] is 

checked, data can then be entered into [Project/Site name]. 

Check [Start date for test] to set a test start date to search for. Check [Customer name] to set a customer 

name to search for. 

 

 
Figure 9.3.7 

 

Select button 
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When several search items have been entered, AND search or OR search can be selected. If the AND 

search is checked, report data which matches both conditions will be searched for. If the OR search is 

checked, report data which matches one or more of the conditions will be searched for. 

 

For example, if information is entered as below, report data in which the project/site name is "Air 

Conditioning System" and the start date is "February 2nd 2011", or the customer name is "Toshiba", will 

be searched for. 

 

 
Figure 9.3.8 

 

 

9.4. Deleting report data 

Registered report data can be deleted. To erase report data, select the report data to be deleted and click 

the [Delete] button. 

 

 

Figure 9.4.1 

 

A delete confirmation message is displayed. Click the [OK] button to delete the data. Clicking the [OK] 

button deletes the report data from the database file. 

Delete button 
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Figure 9.4.2 

 

 

9.5. Printing out report data 

Report data can be printed out. To print report data, select [Print...] from the [File] menu. 

 

 

Figure 9.5.1 

 

A start printing confirmation message is displayed. Click [OK] to start printing. The test operation report 

printing screen is displayed when the [OK] button is clicked. 

 

 
Figure 9.5.2 

 

On the print screen, the printer settings, number of copies and printing format can be set. 

Click the [Property] button to change the printer settings. A print dialogue is displayed. The number of 

copies can also be input directly. 
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Figure 9.5.3 

 

 

 
Figure 9.5.4 

 

Click the [OK] button to print the test operation report. 

 

  

Property button 

No. of copies 
Indoor unit print format settings 
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10. TOSHIBA CARRIER SOFTWARE LICENSE AGREEMENT 
 

IMPORTANT: PLEASE READ TERMS AND CONDITIONS OF THIS AGREEMENT CAREFULLY 

BEFORE USING “DynaDoctor V SOFTWARE” (HEREINAFTER CALLED “THE SOFTWARE”). BY 

USING OR INSTALLING A WHOLE OR A PART OF THIS SOFTWARE, YOU (HEREINAFTER CALLED 

“USER”) ARE DEEMED TO ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF 

USER DO NOT AGREE TO THESE TERMS AND CONDITIONS, DO NOT USE OR INSTALL THE 

SOFTWARE AND RETURN TO THE LOCATION FROM WHITCH IT WAS OBTAINED.  

 

1. For the purpose of this Agreement, ”Software” means the computer programs and information and 

data (including without limitation electric documents) contained in the media or files distributed with 

this Agreement., except those specifically excluded not as a part of the software in writing. 

2. The Software is the property of Toshiba Carrier Corporation. Toshiba Carrier Corporation owns all 

intellectual properties in the software. User may use the Software only in accordance with the terms 

and conditions of this Agreement, and only for such purpose as designated by Toshiba Carrier 

Corporation or as agreed to by Toshiba Carrier Corporation. 

3. Toshiba Carrier Corporation owns the copyright of the software and data in the software. The 

software is protected under applicable copyright law and international conventions.   

4. User may copy and install this Software for such purpose as described in the documents of the 

Software. Any copy created by User shall be immediately destroyed immediately after necessity of 

such copy are ended. With an exception of the forgoing, User shall not make any copy of the 

Software;  

5. User shall not reverse engineer, decompile, disassemble, or modify the Software. 

6. User shall not use the software with plural people within any internal network or Internet. 

7. User shall not distribute, transfer, rent, lease, or sell its right to use the Software to anyone. 

8. User shall respect the intellectual property right of the software. User understand the confidential 

nature of the Software and agrees to safeguard the software from disclosure to any third party. 

9. User shall comply with the Foreign Exchange and Foreign Trade Control Laws and other related 

export regulations applicable in Japan. User shall comply with the U.S Export Administration 

Regulations, export control laws and regulations of all other countries.  
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10. THIS SOFTWARE ARE PROVIDED “AS IS” WITHOUT ANY WARRANTY OF ANY KIND, EITHER 

EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY AND 

FITNESS FOR A PARTICULAR PURPOSE. TOSHIBA CARRIER CORPORATION HEREBY 

DISCLAIMS ANY WARRANTIES RELATING TO QUALITY AND PERFORMANCE OF THE 

SOFTWARE. TOSHIBA CARRIER CORPORATION SHALL NOT BE LIABLE FOR ANY DAMAGES, 

LOSSES, EXPENSES OR COSTS, IF ANY, INCURRED IN CONNECTION WITH OR AS A RESULT 

OF THE USE OF THE SOFTWARE. 

Toshiba Carrier Corporation reserve a right to make modification or improvement of the software at 

any time. 

11. In the case of breach any terms and conditions of this Agreement, or this Agreement be terminated or 

expired, User shall de-install the Software, scrap the Software any/or return the media and/or the files 

of Software to Toshiba Carrier Corporation immediately, along with any remaining copies thereof. 

12. Toshiba Carrier Corporation may request User to stop using the Software at any time upon notice to 

USER. 

13. This Agreement are governed and construed by the laws of Japan.  
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